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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG ("Siemens"). They are 
non-binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 

Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 

By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  

The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with Industrial Security functions that support the secure 
operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 

Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  

For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 

 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Overview 

The standardization of automation engineering for process plants, such as in the 
chemical industry, is a major challenge. Different process steps and procedures, 
and diverse equipment and flexibility levels in production make the task even more 
difficult.  

This includes the plant structure according to the ISA-106. This specifies the lower 
four levels, i.e. plant area, unit, equipment and device. A plant always consists of 
units. The units contain standardized equipment modules. 

Overview of complete solution 

The following picture shows the process scheme of a typical chemical plant with 
three stirred tank reactors and two distillation columns (highlighted with a red 
frame). 

 

Description 

The "Distillation Column" unit template includes several pre-built, unified and 
ready-connected equipment modules. Using this sample solution as a basis, 
numerous instances with different parameter assignments can be generated with 
adapted characteristics to be widely integrated in automation solutions. The PCS 7 
project is configured to be hardware-independent and can be flexibly incorporated 
into existing projects. 
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Exclusions 

The following cases are not covered by the "Distillation column" unit template: 

 Multicomponent distillation, i.e. columns with additional side draws 

 Columns with gaseous head products that require a different pressure control 
structure 

 Vacuum columns with a special pressure control structure 

 Strippers, i.e. columns without the reinforcement part 

 Columns that have no representative temperature as a control variable 

Required knowledge 

Fundamental knowledge of the following specialist fields is a prerequisite: 

 Engineering with SIMATIC PCS 7 and the APL library 

 Knowledge of control technology 

 Basic knowledge of process technology 
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1.2 Mode of operation 

The quality of material separation is measured by the purity of the separation 
products, i.e. after concentration by low and high boilers in the head and bottom 
outlet. The measuring of these concentrations by means of online analyzers is so 
complex, that it is omitted in most plants. Thermodynamic correlations are formed 
in the phase equilibrium (between vapor and liquid) at the individual trays of the 
column, so there is also a correlation between the concentrations and 
temperatures. The easily measurable temperatures are used as substitute control 
variables. This has the additional advantage that the relationship between the 
temperatures and control interventions can linearize more easily than the 
connection between the concentrations. 

The "Distillation column" unit template provides an example of a process plant. The 
example project has been implemented as a PCS 7 multiproject as follows: 

 One project for the automation system (AS) and one project for the operator 
station (OS) are included in the component view. 

 A hierarchy folder has been created in the technological hierarchy for each 
equipment module. 

The AS project contains all open- and closed-loop control functions in the form of 
CFC (Continuous Function Chart) charts. The PCS 7 project also contains an 
example simulation of a distillation column (random packings or packed columns) 
for distilling isopropanol (low boilers) and butanol (high boilers). 

Note Technical functions are referred to as equipment modules, whereas individual 
control units and individual control unit types are called control modules or 
control module types. This documentation uses the terms: equipment module, 
control module (CM) and control module type (CMT). 

 

The AS project was created using the APL library (Advanced Process Library), 
which among other things also includes a model predictive multivariable controller. 
The multivariable controller is the core element of the control strategy and takes 
over the regulation of the head and bottom temperature in the distillation column. 
Further closed-loop controllers are connected subordinately to the multivariable 
controller. 

The process screens contain the most important parameters (KPI: Key 
Performance Indicators) of the distillation column, as well as all detailed information 
on the individual components and components for operation and monitoring. 

For an optimized process control and monitoring, two additional process screens 
have been created with Advanced Process Graphics (APG). They are clear and 
reduced to the essentials. The process images focus on how to consider the 
relevant process screens within the work areas. 
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1.2.1 Core functionality 

The individual components of the column are described in the following section. It 
is operated in the PCS 7 Operator Station. 

The visualization interface of the "Distillation column" unit template is composed of 
the following pictures: 

 Plant overview picture for orientation and navigation (Level 1) 

 Process screen for operation and monitoring (Level 2) 

 Detailed process screen in P&ID representation with all components (Level 3) 

 

 

 

Plant overview 

The overview picture consists of the following objects: 

 Spider graph representation of typical distillation column parameters and 
temperatures 

 Bar graph representation of the feed into the column and removal of the two 
products from low boilers and high boilers 
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Process image 

The process screen shows the most important process values for monitoring and 
operating the distillation column. From the associated faceplate, you can get further 
detailed information about each displayed value and make changes. The trend 
display shows the actual, target and control variables of the multivariable controller. 

 

 

Detailed process screen 

The process screen shows a schematic representation of the block icons of the 
sensors and actuators. The process screen also includes an overview of the Key 
Performance Indicators. The process screen gives the operator an overview of the 
entire plant and enables him to take the necessary operator actions. 

 



1 Introduction 

 

Distillation Column 
Entry-ID: 48418663,    V3.0,    05/2018   10 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

1.2.2 Control concept 

A multivariable controller (MPC) is used for controlling the distillation process. This 
controls the temperatures below the head and above the bottom (also refer to 
Chapter Temperature characteristic). These control variables are detected by the 
relevant temperature measuring points of the head and bottom temperatures. The 
manipulated variables of the multivariable controller are used as a setpoint for 
underlying PID controllers. The two level controls of the distillation column are 
provided with PID controllers and work independently.  
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1.2.3 P&ID flow diagram 

The following figure shows the individual elements of a distillation column in a 
piping and instrument flow diagramm.  
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1.3 Hardware and software components 

Validity 

This application is valid from SIMATIC PCS 7 V9.0. 

Components used 

The application example has been created with the following hardware and 
software components:  

Component Note 

SIMATIC PCS 7 ES/OS IPC547G W7 For the PCS 7 V9.0 example project 

SIMATIC PCS 7 V9.0 Part of SIMATIC PCS°7 ES/OS IPC547G W7 

S7 PLCSIM The license does not form part of the  
SIMATIC PCS 7 

APL Library V9.0 Part of SIMATIC PCS°7 V9.0 

APG Library V9.0 The license does not form part of the  
SIMATIC PCS 7 

 

Note In case of different hardware, please observe the minimum requirements for 
installing the software components. The minimum requirements can be found in 
the Readme file of the PCS 7.  

 

Note The download contains elements that require a license. Use in your configuration 
environment or in the process mode obligates you to purchase the appropriate 
PCS 7 Advanced Process Graphics (APG) license. 

Ordering information can found at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109750232. 

 

This application example consists of the following components:  

Component Note 

48418663_DistillColumn_PROJ_PCS7V90.zip PCS 7 V9.0 Example project 

48418663_DistillColumn_DOC_PCS7V90_en.pdf This document 

 

Note The example project for PCS 7 V9.0 is available for download in the Extranet 
area of the entry: 
https://support.industry.siemens.com/cs/ww/en/view/48418663.  

This Extranet area is only visible if you have a Managed System Services 
contract. You can obtain detailed information at: 
https://support.industry.siemens.com/cs/ww/en/sc/4361. 

You can find an overview of all technical information and solutions, available to 
you exclusively in the Extranet, at the following topics page: 
https://support.industry.siemens.com/cs/ww/en/view/109755371. 

 

https://support.industry.siemens.com/cs/ww/en/view/109750232
https://support.industry.siemens.com/cs/ww/en/view/48418663
https://support.industry.siemens.com/cs/ww/en/sc/4361
https://support.industry.siemens.com/cs/ww/en/view/109755371
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2 Preparation and commissioning 

2.1 Preparation 

The following instructions describe how to commission the Unit Template by 
simulating the controller with the "S7 PLCSIM" program. If there is a real controller, 
you must configure existing hardware components in the HW Config. 

1. Copy the file "48418663_DistillColumn_PROJ_PCS7V90.zip" into any folder 
on the configuration PC and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"48418663_DistillColumn_PROJ_PCS7V90.zip". Then confirm by clicking on 
"Open". 

3. Select the folder in which the project is to be saved and confirm by clicking on 
"OK". 
The project is retrieved. 

4. Confirm the "Retrieve" dialog by clicking on "OK" and then click on "Yes" in the 
dialog to open the project. 

5. Right-click on "ChColumn_OS_Prj > OS01 > WinCC Appl. > OS" and then click 
on the menu command "Open object". 

6. Confirm the "Configured server not available" dialog with "OK". 

7. In WinCC Explorer, open the properties of your computer and, in the opened 
Properties dialog, click on the "Use Local Computer Name" button. 

 

 

 

8. Confirm the "Change computer name" message with "OK". 

9. In the WinCC Explorer, click on "File > Exit" and in the subsequent dialog 
select "Terminate WinCC Explorer and close project".  

10. Then confirm with "OK". 

11. Reopen the WinCC Explorer as described in step 5. 

12. Open by double-clicking on "Variables library". 

13. In the "WinCC Configuration Studio", open "Variables library > SIMATIC S7 
Protocol Suite > TCP/IP" and select the menu command "System parameters". 

14. In the "Unit" tab, check the "Logical device names" setting. If the "S7 PLCSIM" 
program is used, the device name "PLCSIM.TCPIP.12" is selected.  
A restart is required after a device name change. 

Note If the OS cannot establish a connection with the AS (grayed out module icons), 
select the logical device name "CP_H1_1" and restart the OS runtime. 
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2.2 Commissioning 

The following instructions show how the Unit Template is initialized. The project 
contains an SFC chart where all the important settings are configured so that die 
system reaches the operating point.  

To put into service, it is required that SIMATIC Manager is already open and that 
the Unit Template has been selected in the component view. 

Starting the simulation (S7 PLCSIM) 

To start the simulation, proceed as follows: 

1. Select "Tools > Simulate Modules" from the menu. 
The "S7 PLCSIM" dialog window opens. 

2. In the "Open project" dialog, select "Open project from file". 

3. Select the file "ChColumn.plc" from the path 
<Projektpfad>\ChColumn\ChCo_AS\ChColumn.plc>. 

4. In the menu, change "PLCSIM(MPI)" to "PLCSIM(TCP/IP)".  

5. In the menu, select "Run > key switch position > RUN-P". 

6. Switch to the component view of the SIMATIC Manager and mark 
"ChColumn_AS_Prj > AS01". 

7. On the menu bar, click on "Target system > Load" and confirm the "Load" 
dialog with "Yes".  

8. Confirm the "Stop target group" dialog with "OK" and the subsequent "Load" 
dialog with "Yes". 

Activate OS (WinCC runtime) 

To activate the OS, proceed according to the following instructions: 

1. Right-click on the OS and select the menu "Open object".  

2. To activate the OS (WinCC Runtime), select the menu command "File > 
Activate" in WinCC Explorer. 

3. In the "System Login" dialog, enter the user "Unit" as "Login" and "Template" 
as the password; then confirm with "OK". 

4. Select "DistillationGroup" in the icon area
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2.3 Components of process visualization 

Depending on the boundary conditions, distillation columns are controlled with 
various configurations. The structure described below is an example of a common 
scenario. 

1

3

4 5

7

62

 

The process screen of the distillation column consists of the following main parts: 

1. Pressure control 

2. Feed 

3. Bottom temperature (vapor) 

4. Distillation column 

5. Capacitor with reflux 

6. Removal of the head product (low boiler) 

7. Removal of the bottom product (high boiler) 

(1) Pressure control 

The head pressure is regulated by the cooling water valve. Using more cooling 
water leads to heavier condensation. Since the volume greatly reduces during 
condensation, the condenser "suctions" vapor out from the column. The inflow and 
outflow of the liquids have very little effect on the pressure due to the different 
densities of liquid and vapor. 

(2) Feed 

The mixture flows to the distillation column via the feed.  

A PID controller regulates the feed (control variable) to the configured setpoint. The 
actual value flows as a disturbance variable to the higher-level multivariable 
controller.  
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 (3) Evaporator (vapor) 

The evaporator removes the liquid mixture from the column bottom and heats it 
until the components evaporate. The gaseous mixture is then returned back into 
the distillation column. 

The vapor (control variable) used for heating the evaporator is regulated by a valve 
(manipulated variable) with a PID controller, which receives the setpoint from the 
multivariable controller. 

(4) Distillation column 

The distillation column is controlled by means of a multivariable controller. The 
temperatures below the head and above the bottom (control variables) are 
recorded and regulated by means of the heating vapor amount or the condensate 
reflux (manipulated variables). The two manipulated variables are used as setpoint 
entries for lower-level PID controllers. 

(5) Capacitor with reflux 

The capacitor removes the gaseous mixture from the head of the column and cools 
it off until both substances (low boilers and high boilers) condense. The liquid 
mixture is partially recirculated to the distillation column. The capacitor also 
includes a tank in which the liquid mixture is stored temporarily in order to enable 
reflux rate control. 

The top pressure of the distillation column (control variable) is controlled via the 
cooling water flow rate (manipulated variable) by means of a PID controller. The 
setpoint value specification is implemented by the operator. 

The reflux (control variable) is controlled by means of a PID controller via a valve 
(manipulated variable). The setpoint is selected from the multivariable controller of 
the distillation column. 

(6) Removal of the head product (low boiler) 

The amount of outflowing head product depends on the fill level of the capacitor 
and cannot be specified. When the entire distillation column has a stable operating 
point, the amount of head product to be removed is composed of the following 
components: 

 Concentration of the low boiler in the feed mixture  

 Feed amount of the distillation column 

The fill level in the condensate tank (control variable) is controlled by a PID 
controller via a valve (manipulated variable). The setpoint value specification is 
implemented by the operator. 

(7) Removal of the bottom product (high boiler) 

The amount of bottom product to be heated depends on the bottom fill level and 
cannot be specified. When the entire distillation column has a stable operating 
point, the amount of bottom product to be removed is composed of the following 
components: 

 Concentration of high boiler in the feed mixture 

 Feed amount of the distillation column 

The fill level in the condensate tank (control variable) is controlled by a PID 
controller via a valve (manipulated variable). The setpoint value specification is 
implemented by the operator. 
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Additional functions 

 Temperature and pressure reading 
The distillation column gives 6 temperature readings and 2 pressure readings: 

– Temperature at the distillation column head 

– Pressure at the distillation column head 

– Temperature for head temperature control 

– Temperature above the feed 

– Temperature below the feed 

– Temperature for bottom temperature control 

– Temperature at the distillation column bottom 

– Pressure at the distillation column bottom 

 Concentration specification 
With regard to the feed, the concentration of the low boiler can be specified in 
the simulation in relation to the high boiler. This concentration ratio is an 
unrecorded disturbance variable for the process. 

 Operating point 
A sequential function chart (SFC) for the ramp up of the distillation column in 
the operating point. 

 

Parameters (KPI = Key Performance Indicator) 

The following key performance indicators are measured or calculated: 

 Pressure drop = pressure at the bottom of the column – pressure at the head 
of the column 

 Relative energy consumption = amount of vapor / production volume of head 
product 

 Reflux ratio: Reflux / discharge of head product 

 

Note The pressure loss describes a measure of the thermodynamic loading of the 
column. 
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2.4 Controlling the application 

2.4.1 Overview  

All components of the distillation column can be controlled and monitored from the 
process screen. In addition, the plant operator receives information (KPIs) for the 
current process. 

 

Note Please note that it takes about 6 minutes for the column to reach the operating 
point after the program starts (PLCSIM). During operational production, all 
controllers are enabled for setpoint changes except the cascade controllers. 

 

The following two scenarios are limited to the two variables that are significantly 
relevant for the operation of a distillation column and which demonstrate the mode 
of operation of the multivariable controller in compensating for interferences. 

 Changing the feed amount 

 Changing the feed concentration 

When the distillation column is in a steady state, the feed amount and the feed 
concentration determine the amount that can be delivered by the head or bottom 
product. A variable, which acts as a disturbance for the controller, is modified in 
each of the two scenarios. 

Note The signal noise for the two control variables has been disabled for trend 
recording and evaluation.  

 

2.4.2 Scenario A - Changing the feed amount 

In this scenario, the concentration of low boilers in the mixture feed is constant and 
the feed amount is increased from 20 L/min to 23 L/min (+15%). The feed amount 
is detected by the controller as a disturbance (DV1 input) and the effect of the 
disturbance is reflected in the process model. 

1. Switch to the Detail view of the distillation column.  

2. Left click the "On/Off" button in the "Process tag name" field to display the 
block names. 

3. Click on the block icon of "TIC_DistBottom" block and click on the trend icon in 
the menu bar of the faceplate.  

4. Click on the block icon for the "FIC_Feed" to also open its faceplate. Arrange 
the windows clearly on the screen. 
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1

2

2

1

 
 

5. Click on the input field "Setpoint" in the "FIC_Feed" block and enter the value 
"23" in the text box of the extension. Then confirm the entry with the Enter key 
and click the "OK" button. 
The setpoint for the feed is accepted and the multivariable controller starts 
compensating the detected disturbance. 

6. Wait about 3 minutes and click on the "Start/Stop" symbol to evaluate the 
control result. 

Evaluation 

The screenshot gives you the trend curves of the multivariable controller. 

Approx. -0.08°C

Approx. +0.1°C

Head control temperature

Bottom control temperature

 

Even a slight deviation of about 0.1 °C gives a good control result, which can be 
explained by the fact that the disturbance has been detected and that the controller 
knows the influence of the disturbance. The controller can thus respond 
immediately to the change of the disturbance with the necessary procedures and 
does not have to wait for changes in the control variables. 

 

2.4.3 Scenario B - Changing the feed concentration 

When the distillation column is in a steady state, the feed amount and the feed 
concentration determine the amount that can be delivered by the head or bottom 
product. In this scenario, the inflow amount remains constant and the concentration 
of low boiler in the feed mixture is lowered from 0.5 to 0.4 (-20%). 

The concentration of low boiler in the feed mixture is an unknown disturbance for 
the controller, which is not recognized according to a model. 
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1. Click on the block icon of "TIC_DistBottom" block and click on the trend icon in 
the menu bar of the faceplate. 

2. Click on the block icon for the "FeedComposition" to also open its faceplate. 
Arrange the windows clearly on the screen. 

1 2

2

1

 
 

3. Click on the input field "Setpoint" in the faceplate of "FeedComposition" and 
enter  
the value "0.4". Then confirm the entry with "ENTER" and click the "OK" button. 
The setpoint for the concentration of low boiler in the fed mixture is applied and 
the multivariable controller starts compensating the disturbance. 

4. Wait about 3 minutes and click on the "Start/Stop" symbol to evaluate the 
control result. 

Evaluation 

The screenshot gives you the trend curves of the multivariable controller. 

Approx. +0.4°C

Head control temperature

Bottom control temperature

Approx. +0.5°C

 

Even a slight deviation of about 0.5 °C gives a good control result, since the size 
and effect of the disturbance variable are unknown to the controller and the 
controller can only react to the change of control variables. 
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3 Integrating the unit template in the user 
project 

3.1 Preparation 

1. Copy the file "48418663_DistillColumn_PROJ_PCS7V90.zip" to the 
configuration PC and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file  
"48418663_DistillColumn_PROJ_PCS7V90.zip ". Then confirm by clicking on 
"Open". 

3. Select the folder in which the project will be saved and confirm with the "OK" 
button. 
The project will be extracted. 

4. In the "Retrieve" dialog, click on the "OK" button and then click on "Yes" in the 
dialog to open the project. 

5. Switch to the "Plant view". 

6. At the same time, open the project in which the fermenter is to be integrated. 

3.2 Copying templates 

Note If you have already worked with CMTs in your existing project, then check that 
they are identical before skipping to the following steps, since this can lead to 
errors in your existing project or in the unit template you want to integrate. 

1. Switch to the plant view. 

2. Copy the "BCM" folder containing the CMTs from the master data library into 
the target project. 
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3.3 Copying units 

1. Copy the hierarchy folder "DistillationGroup" from the AS project of the Unit 
Template to the plant view of the target project. 

 

 

Note The hierarchy folders of the units "01_Overview" and "02_Help" are not 
necessary for operation. These do not have to be copied if you want to operate 
your system without a simulation. 

 

2. Copy the process screen "Plant", the process screen "L2_Distillation" and the 
detailed process screen "L3_Distillation" from the OS project of the unit 
template to the plant view of the target project as well. If you wish, you can also 
copy the pictures "Help" and "Overview". 

 

Note When copying the process screens, make sure that you copy the pictures to the 
hierarchy level of the target project, which is configured as an OS area. 
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3.4 Adapting the OS project 

In order to facilitate the changing of colors in the process screen from a central 
point, a central color palette was created in the OS project of the Unit Template. To 
display these colors in the process screen of your own project, you must import the 
relevant color palette. 

1. Select the "OS" in WinCC Explorer and choose "Object properties..." in the 
shortcut menu. 

2. Choose the "User Interface and Design" (1) tab and click the "Edit" (2) button. 

3. Import the palette into your own project (3) by means of the "Overwrite" option. 
The color palette is located in the project folder of the unit template at the path: 
"<Project path>\ChColumn\ChCo_OS\wincproj\OS\GraCS\UnitTemplate.xml 
All existing colors will be replaced. 

1

2

3

 

Note Please note that all colors are always used when exporting/importing color 
palettes. It is not possible to export partial color tables.  

 

If you have created your own color tables in your project, you can also export them 
and use an editor to merge the tables in the Xml file. Otherwise you can create a 
new color table in your project and configure the colors individually. Make sure, too, 
that the color index does not change, otherwise you will have to adjust the color 
settings of the objects in the process screen. Of course it is up to you to change the 
colors according to your requirements. 
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4 Engineering 

4.1 Equipment modules and control modules 

The unit template "Distillation column" consists of pre-made equipment modules 
and additional measuring points. In a PCS 7 project, all measuring points including 
the measuring points of the equipment modules are based on CMTs (control 
module types) from the master data library. 

This application example contains the following components: 

 Head pressure control 

 Inflow "Feed" 

 Evaporator "Heating" 

 Capacitor with reflux "Reflux" 

 Removal of the head product "HeadLevel" 

 Removal of the bottom product "BottomLevel" 

 Distillation 

 Overarching process simulation "Process" 

 Step sequencer (SFC) for starting up the distillation column 

 Process key figures "KPI" 

 Maintenance characteristics "Maintenance" 

 Optimized process control with APG 

 

Note All necessary descriptions, configurations and procedures pertaining to the  

 design, functionality of equipment modules including parameters 

 integration of equipment modules 

 controllers and control response 

can be found in the application description "Equipment Modules for SIMATIC 
PCS 7 using the example of the Chemical Industry" and the example projects 
with the individual equipment modules and CMTs at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/53843373. You will find the 
information on the specific equipment modules in the chapter "Equipment 
Modules" and on the CMTs in the chapter "Control Module". 

 

In the following sections you will find the setup of the specific equipment modules 
as well as the extension and modifications made vis-à-vis the equipment modules 
and the CMTs used. This also includes a description of the SFC for starting up the 
reactor. 

 

Note CMTs are pre-configured for different operating ranges. The use of variants 
allows the corresponding channel block to be selected or deselected based on 
measured value transfer. It is also possible to use options to activate additional 
functions without configuring the instance. 

 

https://support.industry.siemens.com/cs/ww/en/view/53843373
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4.2 Head pressure control "Pressure" 

The amount of mixture removed from the column head is determined with the 
pressure control. 

Note For more demanding applications where fluctuations or other unpleasant 
properties of the actuator can be compensated (e.g. nonlinear valve 
characteristic curve), the equipment module "Temperature-Flow Cascade" can 
be used for pressure control. 

 

4.2.1 Setup 

The pressure is controlled by means of a PID controller with a fixed setpoint value 
specification by the step sequencer. During process mode, the setpoint can be set 
by the operator in the defined area. 

The following table provides an overview of the CM and the selected variants.  

CM CMT Variant Description 

PIC_ColuHead "Ctrl" Ctrl_Std Head pressure control 

YC_ColuHead "ValAn" ValAn_Std Control valve for the cooling water going 
to the heat exchanger 

 

In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form. 

Sim_ColuHead

Lag_ColuHead

Noise_ColuHead

Noise

In

PIC_ColuHead

PV_In

SimPV_In

to_Actor_Slave

Out

from_Actor_Slave

In

YC_Cocatalyst

C

MV

from_Ctrl

In

to_Ctrl

Out

 

 "Sim_ColuHead" simulation 

In the simulation chart, the process value is simulated by the setpoint change 
(delay time and process gain).  

1 2 3

 

1. Lag time of 10 seconds, which is caused by the inertia of the actuator as well 
as by the time constant of the flow sensor. 

2. The gain factor for the simulation of the process gain. 

3. Connecting noise to the manipulated variable 
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4.2.2 Parameter assignment 

 PIC_ColuHead 

The instance has the following parameterization. 

Block Connection Value Use 

PV_Scale HiScale 2 Process value upper limit 

PV_Unit In 1137 Process value unit in bar 

C Gain 6 Controller gain 

C TI 3.5 Controller lag 

C SP_InHiLim 1.5 Upper limit of the internal setpoint 

C SP_InLoLim 0.8 Lower limit of the internal setpoint 

C PV_AH_Lim 1.8 Alarm upper limit for the process value 

C PV_WH_LIM 1.5 Warning upper limit for the process value 

C PV_WL_Lim 0.8 Warning lower limit for the process value 

C PV_AL_Lim 0.5 Alarm lower limit for the process value 

C PV_Hyst 0.2 Hysteresis for the limit values 

C 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

C MV  
Interconnection for the simulation  
(Sim_ColuHead\Lag_ColuHead.In) 

C PV_Out  
Interconnection for  
(Distillation\\KPI\pBotMinus_pHead.In2) 

to_Actor_Slave Out  
Interconnection for the valve 
(YC_ColuHead\from_Ctrl.In) 

from_Actor_Slave In  
Interconnection for the valve 
(YC_ColuHead\to_Ctrl.Out) 

PV SimPV_In  

Interconnection for the simulated process 
value 
(Sim_ColuHead\Noise_ColuHead.Noise) 

 

 YC_ColuHead 

The instance has the following parameterization.  

Block Connection Value Use 

from_Ctrl In  
Interconnection for the controller  
(FIC_ColuHead\to_Actor_Slave.Out) 

to_Ctrl Out  
Interconnection for the controller 
(FIC_ColuHead\from_Actor_Slave.In) 
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4.3 Inflow "Feed" 

The mixture to be separated is fed to the distillation column via the inlet in a 
constant flow. The flow volume acts as a disturbance on the multivariable 
controller. 

 

4.3.1 Setup 

Inflow control is performed by means of a standard PID controller with a setpoint 
value specification by the step sequencer. During process mode, the setpoint can 
be set by the operator in the defined area. 

The following table provides an overview of the CM and the selected variants.  

CM CMT Variant Description 

FIC_Feed "Ctrl" Ctrl_Std Flow controller for the input material mixture 

YC_Feed "ValAn" ValAn_Std Analog control valve for the input material 
mixture 

 

In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form.  

Sim_Feed

Lag_Feed

Gain_Feed

OUT

In

FIC_Feed

PV_In

SimPV_In

to_Actor_Slave

Out

from_Actor_Slave

In

YC_Cocatalyst

C

MV

from_CTRL

In

to_CTRL

Out

 

 "Sim_Feed" simulation 

The mixture feed is simulated in the simulation chart.  

1 2

 

1. Lag time of 2 seconds, which is caused by the inertia of the actuator as well as 
by the time constant of the flow sensor. 

2. The gain factor for the simulation of the process gain. 
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4.3.2 Parameter assignment 

 FIC_Feed 

The instance has the following parameterization.  

Block Connection Value Use 

PV_Unit In 1352 Unit of the process value in L/min 

C TI 2.0 Controller lag 

C SP_InHiLim 25.0 Upper limit of the internal setpoint 

C SP_InLoLim 15.0 Lower limit of the internal setpoint 

C PV_AH_Lim 30 Alarm upper limit for the process value 

C PV_WH_LIM 25 Warning upper limit for the process value 

C PV_WL_Lim 0 Warning lower limit for the process value 

C PV_AL_Lim 30 Alarm lower limit for the process value 

C 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

C MV  
Interconnection for the simulation  
(Sim_Feed\Lag_Feed.In) 

C PV_Out  

Interconnection for  
(Distillation\\TIC_DistBottom\MPC.DV1) 
(Process\\Sim_ProcModel\F_Norm.In1) 
(Distillation\\KPI\MassBalance.In1) 

to_Actor_Slave Out  
Interconnection for the valve 
(YC_Feed\from_Ctrl.In) 

from_Actor_Slave In  
Interconnection for the valve 
(YC_Feed\to_Ctrl.Out) 

PV SimPV_In  

Interconnection for the simulated process 
value 
(Sim_Feed\Gain_Feed.Out) 

 

 YC_Feed 

The instance has the following parameterization.  

Block Connection Value Use 

from_Ctrl In  
Interconnection for the controller  
(FIC_Feed\to_Actor_Slave.Out) 

to_Ctrl Out  
Interconnection for the controller 
(FIC_Catalyst\from_Actor_Slave.In) 

 



4 Engineering 

 

Distillation Column 
Entry-ID: 48418663,    V3.0,    05/2018   29 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4.4 Evaporator "Heating" 

The temperature of the column is determined by pumping the mixture at the 
column bottom through the external heat exchanger. 

 

4.4.1 Setup 

Flow control is performed by means of a standard PID controller and an external 
setpoint from the multivariable controller "TIC_DistBottom". The following table 
gives you an overview of the CM and the selected variants.  

CM CMT Variant Description 

FIC_Vapor "Ctrl" Ctrl_Std  
Activated option "Opt_IF_Master" 

Vapor flow control  

YC_Vapor "ValAn" ValAn_Std Control valve for the vapor feed to the 
heat exchanger 

 

In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form.  

Sim_Vapor

Lag_Vapor

Gain_Vapor

OUT

In

FIC_Vapor

PV_In

SimPV_In

to_Actor_Slave

Out

from_Actor_Slave

In

YC_Vapor

C

MV

from_CTRL

In

to_CTRL

Out

 

 "Sim_Vapor" simulation 

In the simulation chart, the process value is simulated by the setpoint change 
(delay time and process gain).  

1 2

 

1. Lag time of 5 seconds, which is caused by the inertia of the actuator as well as 
by the time constant of the flow sensor. 

2. The gain factor for the simulation of the process gain. 
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4.4.2 Parameter assignment 

 FIC_Vapor 

The instance has the following parameterization.  

Block Connection Value Use 

PV_Scale HiScale 10 Process value upper limit 

PV_Unit In 1352 Unit of the process value in L/min 

C Gain 10 Controller gain 

C TI 2.5 Controller lag 

C SP_InHiLim 4.0 Upper limit of the internal setpoint 

C SP_InLoLim 2.0 Lower limit of the internal setpoint 

C PV_AH_Lim 4.5 Alarm upper limit for the process value 

C PV_WH_LIM 4.0 Warning upper limit for the process value 

C PV_WL_Lim 2.0 Warning lower limit for the process value 

C PV_AL_Lim 1.0 Alarm lower limit for the process value 

C PV_Hyst 0.1 Hysteresis for the limit values 

C 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

C MV  
Interconnection for the simulation  
(Sim_Vapor\Lag_Vapor.In) 

C PV_Out  

Interconnection for  
(Process\\Sim_ProcModel\V_MinusV0.In1) 
(Distillation\\KPI\VaporDivDistFlow.In1) 

to_Actor_Slave Out  
Interconnection for the valve 
(YC_Vapor\from_Ctrl.In) 

from_Actor_Slave In  
Interconnection for the valve 
(YC_Vapor\to_Ctrl.Out) 

to_Master Out  
Interconnection for the master controller 
(TIC_DistBottom\from_Ctrl_2.In) 

from_Master In  
Interconnection for the master controller 
(TIC_DistBottom\to_Ctrl_2.Out) 

PV SimPV_In  

Interconnection for the simulated process 
value 
(Sim_Vapor\Gain_Vapor.Out) 

 

 YC_Vapor 

The instance has the following parameterization.  

Block Connection Value Use 

from_Ctrl In  
Interconnection for the controller  
(FIC_ColuHead\to_Actor_Slave.Out) 

to_Ctrl Out  
Interconnection for the controller 
(FIC_ColuHead\from_Actor_Slave.In) 
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4.5 Capacitor with reflux "Reflux" 

The temperature of the low boiler is reached by returning the condensate (head 
product). 

 

4.5.1 Setup 

Flow control is performed by means of a standard PID controller and an external 
setpoint from the multivariable controller "TIC_DistBottom". The following table 
gives you an overview of the CM and the selected variants.  

CM CMT Variant Description 

FIC_Reflux "Ctrl" Ctrl_Std 
Activated option "Opt_IF_Master" 

Condensate flow control 

YC_Reflux "ValAn" ValAn_Std Control valve for condensate reflux 
to the column 

NS_PumpReflux "Mot" Mot_Std Pump (e.g. flow pump) for returning 
the condensate to the column 

 

In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form.  

Sim_Reflux

Lag_Reflux

Gain_Reflux

OUT

In

FIC_Reflux

PV_In

SimPV_In

to_Actor_Slave

Out

from_Actor_Slave

In

YC_Reflux

C

MV

from_CTRL

In

to_CTRL

Out

 

"Sim_Reflux" simulation 

The condensate flow is simulated in the simulation chart.  

1 2

 

1. Lag time of 2 seconds, which is caused by the inertia of the actuator as well as 
by the time constant of the flow sensor. 

2. The gain factor for the simulation of the process gain. 

4.5.2 Parameter assignment 

 FIC_Reflux 

The instance has the following parameterization.  

Block Connection Value Use 

PV_Scale HiScale 50 Process value upper limit 
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Block Connection Value Use 

PV_Unit In 1352 Unit of the process value in L/h 

C Gain 10 Controller gain 

C TI 2.5 Controller lag 

C SP_InHiLim 10.0 Upper limit of the internal setpoint 

C SP_InLoLim 2.0 Lower limit of the internal setpoint 

C PV_AH_Lim 20.0 Alarm upper limit for the process value 

C PV_WH_LIM 18.0 Warning upper limit for the process value 

C PV_WL_Lim 2.0 Warning lower limit for the process value 

C PV_AL_Lim 0.0 Alarm lower limit for the process value 

C PV_Hyst 0.5 Hysteresis for the limit values 

C 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

C MV  
Interconnection for the simulation  
(Sim_Reflux\Lag_Reflux.In) 

C PV_Out  

Interconnection for  
(Process\\Sim_ProcModel\L_MinusL0.In1) 
(Distillation\\KPI\RefluxDivDistFlow.In1) 

to_Actor_Slave Out  
Interconnection for the valve 
(YC_Reflux\from_Ctrl.In) 

from_Actor_Slave In  
Interconnection for the valve 
(YC_Reflux\to_Ctrl.Out) 

to_Master Out  
Interconnection for the master controller 
(TIC_DistBottom\from_Ctrl_1.In) 

from_Master In  
Interconnection for the master controller 
(TIC_DistBottom\to_Ctrl_1.Out) 

PV SimPV_In  

Interconnection for the simulated process 
value 
(Sim_Reflux\Gain_Reflux.Out) 

 YC_Reflux 

The instance has the following parameterization.  

Block Connection Value Use 

from_Ctrl In  
Interconnection for the controller  
(FIC_Reflux\to_Actor_Slave.Out) 

to_Ctrl Out  
Interconnection for the controller 
(FIC_Reflux\from_Actor_Slave.In) 

 NS_PumpReflux 

No parameter change with regard to the type. 



4 Engineering 

 

Distillation Column 
Entry-ID: 48418663,    V3.0,    05/2018   33 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4.6 Removal of the head product "HeadLevel" 

Condensate level control is performed via the upper product discharge and is 
realized with the equipment module "Level-Control". The level simulation is 
performed in the higher-level process simulation "Sim_ProcModel". The return tank 
serves as a buffer, ensuring that the condensate return to the column is as 
continuous as possible. 

 

4.6.1 Setup 

Level control is performed by means of a standard PID controller with a setpoint 
value specification by the step sequencer. During process mode, the setpoint can 
be set by the operator in the defined area. 

The following table provides an overview of the CM and the selected variants.  

CM CMT Variant Description 

LIC_RefluxDrum "Ctrl" Ctrl_Std Source "Level-Control" for level control 

YC_RefluxDrum "ValAn" ValAn_Std Source "Level-Control" as a control valve for the 
product discharge 

 

4.6.2 Parameter assignment 

 LIC_RefluxDrum 

The instance has the following parameterization.  

Block Connection Value Use 

PV_Scale HiScale 100 Process value upper limit 

PV_Unit In 1342 Process value unit in % 

C Gain 1.0 Controller gain 

C TI 1.0 Controller lag 

C SP_InHiLim 100.0 Upper limit of the internal setpoint 

C PV_AH_Lim 95.0 Alarm upper limit for the process value 

C PV_WH_LIM 90.0 Warning upper limit for the process value 

C PV_WL_Lim 10.0 Warning lower limit for the process value 

C PV_AL_Lim 5.0 Alarm lower limit for the process value 

C 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

C MV  

Interconnection for  
(Process\\Sim_ProcModel\D_Norm.In1) 
(Distillation\\KPI\ValveCharDist.In1) 

to_Actor_Slave Out  
Interconnection for the valve 
(YC_RefluxDrum\from_Ctrl.In) 

from_Actor_Slave In  
Interconnection for the valve 
(YC_RefluxDrum\to_Ctrl.Out) 

PV SimPV_In  

Interconnection for the simulated process 
value 
(Process\\Sim_ProcModel\mD_Prozent.OUT) 
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 YC_RefluxDrum 

The instance has the following parameterization.  

Block Connection Value Use 

from_Ctrl In  
Interconnection for the controller  
(LIC_RefluxDrum\to_Actor_Slave.Out) 

to_Ctrl Out  
Interconnection for the controller 
(LIC_RefluxDrum\from_Actor_Slave.In) 

 

4.7 Removal of the bottom product "BottomLevel" 

The level of the low boiler is controlled via the bottom product discharge and is 
realized with the equipment module "Level-Control". The level in the column bottom 
is performed in the higher-level process simulation "Sim_ProcModel". 

 

4.7.1 Setup 

Level control is performed by means of a standard PID controller with a setpoint 
value specification by the step sequencer. During process mode, the setpoint can 
be set by the operator in the defined area. 

The following table provides an overview of the CM and the selected variants.  

CM CMT Variant Description 

LIC_Bottom "Ctrl" Ctrl_Std Source "Level-Control" for level control 

YC_Bottom "ValAn" ValAn_Std Source "Level-Control" as a control valve for the 
product discharge 

NS_PumpBottom "Mot" Mot_Std Pump (e.g. flow pump) for removing the low 
boiler 

 

4.7.2 Parameter assignment 

 LIC_Bottom 

The instance has the following parameterization.  

Block Connection Value Use 

PV_Scale HiScale 100 Process value upper limit 

PV_Unit In 1342 Process value unit in % 

C Gain 1.0 Controller gain 

C TI 10.0 Controller lag 

C SP_InHiLim 100.0 Upper limit of the internal setpoint 

C PV_AH_Lim 85.0 Alarm upper limit for the process value 

C PV_WH_LIM 80.0 Warning upper limit for the process value 

C PV_WL_Lim 20.0 Warning lower limit for the process value 

C PV_AL_Lim 15.0 Alarm lower limit for the process value 

C 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

C MV  
Interconnection for the simulation chart  
(Process\\Sim_ProcModel\B_Norm.In1) 
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Block Connection Value Use 

to_Actor_Slave Out  
Interconnection for the valve 
(YC_Bottom\from_Ctrl.In) 

from_Actor_Slave In  
Interconnection for the valve 
(YC_Bottom\to_Ctrl.Out) 

PV SimPV_In  

Interconnection for the simulated process 
value 
(Process\\Sim_ProcModel\mB_Prozent.OUT) 

 

 YC_Bottom 

The instance has the following parameterization. 

Block Connection Value Use 

from_Ctrl In  
Interconnection for the controller  
(LIC_Bottom\to_Actor_Slave.Out) 

to_Ctrl Out  
Interconnection for the controller 
(LIC_Bottom\from_Actor_Slave.In) 

 

 NS_PumpBottom 

No parameter change with regard to the type. 

 

4.8 Distillation 

An optimum thermal separation is needed to produce high-quality low and high 
boilers. For this reason, the different temperature ranges of the column are 
recorded and monitored. A multivariable controller is used to complete the 
separating task (production of distillate) with high quality results and to better 
respond to disturbances. 

 

4.8.1 Setup 

The temperature is controlled as a cascade of multi-variable master controllers 
"TIC_DistBottom" and the slave controllers "FIC_Reflux" and "FIC_Vapor". The 
multivariable controller also monitors the mixture feed as a disturbance. The 
following table provides an overview of the CM and the selected variants.  

CM CMT Variant Description 

TIC_DistBottom "CtrlMPC" Ctrl_Std Multivariable controller as a master controller 

TI_HeadPacking "AMon" AMon_Std 
activated option 
"Opt_IF_MPC" 

Measuring point for displaying the upper 
separating temperature 

TI_BottomPacking "AMon" AMon_Std 
activated option 
"Opt_IF_MPC" 

Measuring point for displaying the lower 
separating temperature 
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In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form.  

FIC_Reflux

Sim_TempNorm

XC_Product

MPC

DV1

from_CV1

In

from_Master

In

to_Master

Outfrom_CV2

In

to_Ctrl1

Out

to_Ctrl2

Out

FIC_Vapor

from_Master

In

to_Master

Out

TI_HeadPacking

PV_In

In
T_D_Celsius

Out

T_B_Celsius

Out

from_Ctrl1

In

from_Ctrl2

In

to_MPC

Out

TI_BottomPacking

PV_In

In

to_MPC

Out

FIC_Feed

C

PV_Out

 

 

4.8.2 Parameter assignment 

 TIC_DistBottom 

The instance is configured by activating the options "Opt_CPM_1" and 
"Opt_CPM_2" for two control variables. The instance has the following 
parameterization.  

Block Connection Value Use 

MPC DV1  

Interconnection for the controller that is 
detected as a disturbance 
(Feed\\FIC_Feed\C.PV_Out) 

MPC DB 40 
Data block with the recorded process 
behavior (process model)  

from_CV1 In  
Interconnection for the control variable 
(TI_HeadPacking\to_MPC.Out) 

from_CV2 In  
Interconnection for the control variable 
(TI_BottomPacking\to_MPC.Out) 

from_Ctrl1 In  
Interconnection for the slave controller 
(FIC_Reflux\to_Master.Out) 

to_Ctrl1 Out  
Interconnection for the slave controller 
(FIC_Reflux\from_Master.In) 

from_Ctrl2 In  
Interconnection for the slave controller 
(FIC_Vapor\to_Master.Out) 

to_Ctrl2 Out  
Interconnection for the slave controller 
(FIC_Vapor\from_Master.In) 
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Note The blocks for control quality monitoring and system deviation form part of the 
CFC. The respective block icons for display of information are not part of the 
process screens. If necessary, the "Create block icon" function can be activated 
in the block properties. The respective block icons are available in the process 
screen once the OS is compiled. 

 

 TI_BottomPacking 

The instance is configured by activating the "Opt_IF_MPC" option for connection to 
the multivariable controller as a control variable. The instance has the following 
parameterization.  

Block Connection Value Use 

PV_Unit In 1001 Process value unit in °C 

I PV_Hyst 0.3 Hysteresis for the limit values 

I PV_AH_Lim 84.0 Alarm upper limit for the process value 

I PV_WH_LIM 83.0 Warning upper limit for the process value 

I PV_WL_Lim 72.0 Warning lower limit for the process value 

I PV_AL_Lim 71.0 Alarm lower limit for the process value 

I 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

to_MPC Out  
Interconnection to the multivariable controller 
(TIC_DistBottom\from_CV2.In) 

PV_In SimPV_In  
Interconnection for the simulation: 
(Process\\Sim_TempNorm\T_B_Celsius.Out) 

 

 TI_HeadPacking 

The instance is configured by activating the "Opt_IF_MPC" option for connection to 
the multivariable controller as a control variable. The instance has the following 
parameterization.  

Block Connection Value Use 

PV_Unit In 1001 Process value unit in °C 

I PV_Hyst 0.3 Hysteresis for the limit values 

I PV_AH_Lim 73.0 Alarm upper limit for the process value 

I PV_WH_LIM 72.0 Warning upper limit for the process value 

I PV_WL_Lim 67.0 Warning lower limit for the process value 

I PV_AL_Lim 66.0 Alarm lower limit for the process value 

I 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

to_MPC Out  
Interconnection to the multivariable controller 
(TIC_DistBottom\from_CV1.In) 

PV_In SimPV_In  
Interconnection for the simulation: 
(Process\\Sim_TempNorm\T_D_Celsius.Out) 
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4.9 Process simulation (Process) 

The timing of the simulation model of the distillation column is shortened many 
times over in comparison to a real installation to obtain a faster reaction ("time-
lapse"). 

The simulation included in the "Process" folder consists of the following parts: 

 Simulation of the process (CFC "Sim_ProcModel") 

 Conversion of temperature values (CFC "Sim_TempNorm") 

 Integration limit (CFC "Sim_AntiWindUp") 
 

The following CMs are also included in the "Process" folder for measured value 
display: 

 "PI_ColuBottom": Pressure at the column bottom 

 "TI_Head": Temperature at the column head 

 "TI_AboveFeed": Temperature above the mixture feed 

 "TI_BelowFeed": Temperature below the mixture feed 

 "TI_Bottom": Temperature at the column bottom 

Process simulation 

The CFC "Sim_ProcModel" contains all of those parts of the simulation model that 
not only describe an individual system section but also have an overarching nature. 
The role of process simulation is to understand the functioning of the distillation 
column, particularly in relation to the control functions of the multivariable controller 
or to be able to demonstrate it. It does not claim to replicate exactly the real 
physical behavior of a particular distillation column.  

The process model is a 6x4 multivariable system that simulates all the influencing 
input-output combinations in separate partial transfer functions. The simulation is 
designed on the operating point of the process. 

The following figure shows the process model with the corresponding names:  

u1 u2 u3 u4 u5 u6

y1 G1.1 G1.2 G1.3 G1.4 G1.5 G1.6

y2 G2.1 G2.2 G2.3 G2.4 G2.5 G2.6

y3 G3.1 G3.2 G3.3 G3.4 G3.5 G3.6

y4 G4.1 G4.2 G4.3 G4.4 G4.5 G4.6

Reflux Vapor Distill. Flow Bottom flow Flow Inlet Concentr. Inlet Inlet
L V D B F zF

XD y1u1 y1u2 y1u3 y1u4 y1u5 y1u6

xB y2u1 y2u2 y2u3 y2u4 y2u5 y2u6

MD y3u1 y3u2 y3u3 --- --- ---
mB y4u1 y4u2 --- y4u4 y4u5 ---

Level Distillation

Level Bottom

General Model

Derived Process Model (with name in CFC)

Inputs

O
u
tp

u
ts

Concentr.Distillation 

Concentr.Bottom 

 

The process model is divided into two chart partitions in the CFC 
"Sim_ProcModel".  

 Chart partition A 

The chart partition "A" includes transfer functions of an input signal which affect the 
defined output signals. All partial transfer functions have the same general 
structure and are reduced to the essential. 
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The following figure shows the sheet 1, which includes the effects of the "Reflux" 
input signal (L) on all outputs.  

1

2 3

6

3

4

5

 

A partial transfer function may contain up to five components, as can be seen in 
the following examples:  

Partial transfer function with PT behavior "y1u1" with the components 1, 2, 3 

Partial transfer function with IT behavior "y4u1" with the components 1, 3, 4, 5, 6 

 

1. Deviation from operating point: This block allows for the operating point of 
the input to be indicated and the difference to it to be calculated. If necessary, 
some input values can be normalized in advance. 

2. Dead time: Gives the dead time of the partial transfer function. 

3. PT transfer function (Chart-in-Chart): Three delay elements and a 
reinforcing member are switched in succession in the transfer function. 
Furthermore, noise can be added to the output signal. 

4. Sign: Determination of the sign for integration. 

5. Limitation of integration ("SimAntiWindUp" as Chart-in-Chart): The input 
signal for the integrator is pre-checked for overranged and underranged limits 
and the integration of the output value is stopped (output signal). 

6. Integrator: The integrators are used for level simulation. 
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 Chart partition B 

In chart partition "B", the output signals are calculated from all intermediate values 
of the individual inputs. To do this, all the influences of all inputs are added and the 
total is limited to defined limits. The calculated level values are also converted to 
percent. 

Conversion of temperature values 

In the CFC "Sim_TempNorm", the normalized temperatures of "TI_HeadPacking" 
and "TI_BottomPacking", which are used in the simulation model, are converted 
into degrees Celsius. The temperature values above (1) and below (2) the mixture-
addition are output with 5°C difference from the converted temperatures 
"TI_HeadPacking" and "TI_BottomPacking".  

Figure 4-1 

1

2

 

The remaining process values for head temperature, bottom temperature and 
bottom pressure are fixed and issued with a process noise. 
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Integration limit 

The CFC "Sim_AntiWindUp" is carried out using the Chart-in-Chart technique and 
serves as an integration limit for integral transfer functions of the process model. 
The following figure shows the structure of CFC.  

1

2

 

 

Parameter assignment 

 TI_AboveFeed 

The instance is used as a variant "AMon_Std" and has the following 
parameterization.  

Block Connection Value Use 

PV_Unit In 1001 Process value unit in °C 

I PV_Hyst 0.3 Hysteresis for the limit values 

I PV_AH_Lim 82.0 Alarm upper limit for the process value 

I PV_WH_LIM 81.0 Warning upper limit for the process value 

I PV_WL_Lim 69.0 Warning lower limit for the process value 

I PV_AL_Lim 69.0 Alarm lower limit for the process value 

I 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

PV_In SimPV_In  
Interconnection for the simulation: 
(Process\\Sim_TempNorm\T_AboveFeed.Out) 
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 TI_BelowFeed 

The instance is used as a variant "AMon_Std" and has the following 
parameterization.  

Block Connection Value Use 

PV_Unit In 1001 Process value unit in °C 

I PV_Hyst 0.3 Hysteresis for the limit values 

I PV_AH_Lim 83.0 Alarm upper limit for the process value 

I PV_WH_LIM 83.0 Warning upper limit for the process value 

I PV_WL_Lim 71.0 Warning lower limit for the process value 

I PV_AL_Lim 71.0 Alarm lower limit for the process value 

I 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

PV_In SimPV_In  
Interconnection for the simulation: 
(Process\\Sim_TempNorm\T_BelowFeed.Out) 

 

 TI_Bottom 

The instance is used as a variant "AMon_Std" and has the following 
parameterization.  

Block Connection Value Use 

PV_Unit In 1001 Process value unit in °C 

I PV_Hyst 0.3 Hysteresis for the limit values 

I PV_AH_Lim 83.0 Alarm upper limit for the process value 

I PV_WH_LIM 83.0 Warning upper limit for the process value 

I PV_WL_Lim 71.0 Warning lower limit for the process value 

I PV_AL_Lim 71.0 Alarm lower limit for the process value 

I 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

PV_In SimPV_In  
Interconnection for the simulation: 
(Process\\Sim_TempNorm\T_Bottom.Out) 
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 TI_Head 

The instance is used as a variant "AMon_Std" and has the following 
parameterization.  

Block Connection Value Use 

PV_Unit In 1001 Process value unit in °C 

I PV_Hyst 0.3 Hysteresis for the limit values 

I PV_AH_Lim 82.0 Alarm upper limit for the process value 

I PV_WH_LIM 81.0 Warning upper limit for the process value 

I PV_WL_Lim 69.0 Warning lower limit for the process value 

I PV_AL_Lim 69.0 Alarm lower limit for the process value 

I 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

PV_In SimPV_In  
Interconnection for the simulation: 
(Process\\Sim_TempNorm\T_Head.Out) 

 

 PI_ColuBottom 

The instance is used as a variant "AMon_Std" and has the following 
parameterization.  

Block Connection Value Use 

PV_Unit In 1137 Process value unit in bar 

I PV_Hyst 0.01 Hysteresis for the limit values 

I PV_AH_Lim 1.9 Alarm upper limit for the process value 

I PV_WH_LIM 1.8 Warning upper limit for the process value 

I PV_WL_Lim 0.2 Warning lower limit for the process value 

I PV_AL_Lim 0.1 Alarm lower limit for the process value 

I 

PV_AH_En 
PV_WH_En 
PV_WL_En 
PV_AL_En  

Activation of the alarm and warning limit 
monitoring 

PV_In SimPV_In  
Interconnection for the simulation: 
(Process\\Sim_TempNorm\P_ColuBottom.Out) 
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4.10 Sequences 

Step sequencers support the plant operator during start-up and shut-down of a 
plant or in case of faults. 

During start-up the process is placed in the defined operating point. The controllers 
are optimized for the specific operating point and are switched to automatic mode 
when reaching the operating point. 

Different response and control strategies can be implemented in the SFC. In the 
sample project, an SFC is configured. The SFC "StartDistColumn" is configured for 
automatic start-up without user interaction. After start-up, control is transferred to 
the user in automatic mode, allowing him to determine, for instance, the individual 
setpoint values. By stopping or terminating the SFC, the unit is switched to a 
production-free operation. The following sequencers are components of the SFC 
and are described below: 

 Preparation (PREPARING) 

 STARTUP 

The SFCs should be understood as a reference point and must be modified for use 
with real plants, if applicable. 

 

Note The necessary parameters were assigned and the schematic representations 
from the Function Manual "SIMATIC Process Control System PCS 7 Advanced 
Process Library (V9.0)" were used to determine the setpoint value and operating 
mode selection. In the Function Manual you can find information on operating 
modes and setpoint value selection, as well as more detailed information on all 
parameters of the APL blocks. You will find the manual at this link: 
https://support.industry.siemens.com/cs/ww/en/view/109482346. 

 

STARTUP 

When starting the distillation column, the sequencer "STARTUP" is executed at the 
beginning. During the starting phase, the unit from the plant standstill (no 
production) is prepared for operation in its normal state. For this purpose, the 
controllers switch to automatic mode and all controllers receive the relevant 
setpoints for the production process, such as the inflow quantity, the pressure, and 
the temperature in the distillation column. 

After start-up, control is transferred to the user in automatic mode, allowing him to 
determine, for instance, the individual setpoint values. 

The following steps are performed successively in the sequencer: 

1. Resetting the simulation 

2. Initializing the default controller 

3. Presetting the working ranges (setpoints) 

4. Initializing the multivariable controller 

https://support.industry.siemens.com/cs/ww/en/view/109482346
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Shutting down (SHUTDOWN) 

In the "SHUTDOWN" sequencer, the unit is taken into production-free operation. 
This is started in the OS by pressing the "Stop" or "Cancel" buttons within the SFC 
visualization.  

Also, all the controllers, valves and motors/pumps of the distillation column are 
stopped and released for the operator. The process simulation is additionally reset. 
The operator has the possibility of operating all plant units as follows: 

 Controlling all valves 

 Controlling the pumps 

 Changing the setpoint value specifications (internal setpoint) of the controllers 
and monitoring the process 

 Performing controller optimization (changing individual controller parameters or 
using the PID tuner) 

4.11 Process key figures "KPI" 

The CFC "KPI" comprises key performance indicators that inform the operator 
about the process performance. The following key performance indicators are 
calculated and shown in the visualization: 

1. Production volume of the head product:  
Manipulated variable for the level control of the condensate * factor 0.2 
 

2. Production volume of the bottom product:  
Inflow of the input material – production volume of the head product 

 

3. Pressure loss in the column:  
Bottom pressure – pressure at column head 

 

4. Reflux ratio:  
Reflux / production volume of head product 

 

5. Relative energy consumption; 
Vapor amount / production volume of head product 

 

You can also find the operator control block "FeedComposition" on sheet 3. This 
allows the composition of the input material or the separation ratio to be defined. 

 

4.12 Maintenance 

In the CFC "Maintenance", the operation time of the column and the pressure loss 
in the column are continuously monitored with the block "AssetM" and an alarm 
message is thrown if levels are exceeded.  

 

Note The block icon for displaying the maintenance information does not form part of 
the process screens. If necessary, the "Create block icon" function can be 
activated in the block properties. The block icon is available in the process 
screen once the OS is compiled. 
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4.13 Task-related overview screens with APG 

With PCS 7 Advanced Process Graphics, process screens are displayed more 
clearly, reduced to the essentials, and are intuitive to use. The focus lies in the 
consideration of the relevant process variables within the working ranges. In this 
example, the plant overview screen and the process screen are created with APG. 

 

4.13.1 Integration of APG 

The integration of APG is configured in two phases: 

1. Insertion and parameter assignment of APG blocks in the measuring points 
(AS) 

2. Placement and interconnection of APG objects (OS) 

Note You can find basic information on APG, on the extension of an existing PCS 7 
project with APG and on the configuration purposes in the application description 
"Integration of Advanced Process Graphics in SIMATIC PCS 7" at the following 
link: https://support.industry.siemens.com/cs/ww/en/view/89332241. 

 

4.13.2 APG measuring points (AS) 

In the CMT "Ctrl" and "AMon", the APG connector block has been added in chart 
partition "A" "Sheet 4" and linked to the controller or display block. The extended 
CMTs of the master data library are synchronized with the automation project.  

Note The Application Example "Control Module (CM) Technology - Efficient 
Engineering with SIMATIC PCS 7" describes how efficiently an existing project is 
extended to APG by applying the control module technology and can be found at 
the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109475748 

 

Controller measuring points 

The CMT "Ctrl" contains the following parameterization.  

Connection Value Use 

BockType 2 Representation suitable for the "PIDConL" block 

ViewMode 1 Absolute representation (value range) 

ViewRange 4 Display of the working range 

ReadPointer  Connected with "C.Status2" 

 

The following table contains the parameterization of all instances in which the 
"HMI" option has been activated.  

CM Connection Value Use 

LIC_Bottom PV_Ox_Li  No change with regard to the type 

FIC_Feed PV_OH_Li 30.0 Upper limit of the working range 

FIC_Feed PV_OL_Li 0.0 Lower limit of the working range 

FIC_RefluxDrum DispRatio 0.5 Display ratio 

FIC_Vapor PV_OH_Li 10.0 Upper limit of the working range 

https://support.industry.siemens.com/cs/ww/en/view/89332241
https://support.industry.siemens.com/cs/ww/en/view/109475748
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CM Connection Value Use 

FIC_Vapor PV_OL_Li 0.0 Lower limit of the working range 

PIC_ColuHead PV_OH_Li 2.0 Upper limit of the working range 

PIC_ColuHead PV_OL_Li 0.0 Lower limit of the working range 

FIC_Reflux PV_OH_Li 50.0 Upper limit of the working range 

FIC_Reflux PV_OL_Li 0.0 Lower limit of the working range 

 

Display measuring points 

The CMT "AMon" contains the following parameterization.  

Block Connection Value Use 

HMI BockType 1 
Representation suitable for the "PIDConL" 
block 

HMI ViewMode 1 Absolute representation (value range) 

HMI ViewRange 4 Display of the working range 

HMI ReadPointer  Connected with "C.Status2" 

The following table contains the parameterization of all instances in which the 
"HMI" option has been activated.  

CM Connection Value Use 

TI_HeadPacking ViewMode 2 Difference representation 

TI_BottomPacking ViewMode 2 Difference representation 

TI_AboveFeed ViewMode 2 Difference representation 

TI_BelowFeed ViewMode 2 Difference representation 

TI_Bottom ViewMode 2 Difference representation 

TI_Head ViewMode 2 Difference representation 

PI_ColuBottom PV_OH_Li 10.0 Upper limit of the working range 

PI_ColuBottom PV_OL_Li 0.0 Lower limit of the working range 

 

KPI measuring point 

The CFC "KPI" contains five instances of the APG connector blocks. The 
interconnection and parameters of "BlockType", "ViewMode" and "ViewRange" 
correspond to the parameterization of the display measuring point. The following 
table contains the parameterization of the display areas.  

Block Connection Value Use 

HMI_FI_DistProd PX_OH_Li 20.0 Upper limit of the working range 

HMI_FI_DistProd PX_OL_Li 0.0 Lower limit of the working range 

HMI_FI_BottoProd PX_OH_Li 20.0 Upper limit of the working range 

HMI_FI_BottoProd PX_OL_Li 0.0 Lower limit of the working range 

HMI_PressureLost PV_OH_Li 0.5 Upper limit of the working range 

HMI_PressureLost PX_OL_Li 0.0 Lower limit of the working range 

HMI_RefluxRatio PV_OH_Li 10.0 Upper limit of the working range 

HMI_RefluxRatio PX_OL_Li 0.0 Lower limit of the working range 

HMI_EnergyConsum PV_OH_Li 3.0 Upper limit of the working range 

HMI_EnergyConsum PX_OL_Li 0.0 Lower limit of the working range 
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4.13.3 Detecting deviations in the process mode with APG 

The aim of the control is to operate the system in a normal state. This state is 
reached when the controllers are in automatic mode and all controllers receive the 
relevant values for the production process, such as the inflow quantity, the 
pressure, and the temperature in the distillation column in the work area. The APG 
block displays visualize the work area in blue within the display. This allows the 
APG blocks to help visualize the relevant data of the system quickly and clearly. 
The following figure shows the visualization of the normal state of the "distillation 
column" plant.  

 

If the work area is exited, warning and alarm messages can be configured to 
generate messages. This chapter explains the advantages of visualization using 
the additional APG blocks. For this purpose, a disturbance is applied to the Unit 
Template "distillation column". This disturbance simulates a temperature loss, e.g. 
as a result of a heat leak at the measuring point for temperature below the feed. 
The disturbance can be switched on or off at any time using the "disturbance" 
digital switch. 

 

Note Smart Alarm Hiding for alarm management is implemented in the project. This 
means that, depending on the system status, messages can be suppressed 
selectively, preventing them from entering the OS alarm system. Activating the 
disturbance in the "Operation" system state is recommended to ensure that all 
messages are displayed. Further information on Smart Alarm Hiding can be 
found in the chapter "Smart Alarm Hiding". 

 

Setup 

The disturbance is generated in the CFC plan "APG_Disturbance", which switches 
various temperature values between the simulation and the display. In order to 
simulate a disturbance that is as real as possible, a large amount of heat loss is 
simulated at the "TI_BottomPacking" measuring point when the disturbance starts. 
This heat loss decreases continuously until it reaches a small, constant level of 
heat loss. In addition, temperature values are displayed on the two displays of the 
measuring points "TI_AboveFeed" and "TI_BelowFeed". The addition of these 
temperature values to the displays has no effect on the simulation, as the two 
displays only show the measured values in the OS and are not used by the 
controller or the simulation. 
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The following figure shows the components of the simulation for the disturbance. 

1

2

3

4

5

 

1. Calculation of the new temperature value for the measuring point 
"TI_HeadPacking" when the disturbance is activated 

2. Calculation of the new temperature value for the measuring point 
"TI_AboveFeed" when the disturbance is activated 

3. Calculation of the new temperature value for the measuring point 
"TI_BelowFeed" when the disturbance is activated 

4. Calculation of the new temperature value for the measuring point 
"TI_BottomPacking" when the disturbance is activated 

5. Generation of the ramp value for the temperature difference at the measuring 
point "TI_BottomPacking" 
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Evaluation 

 

In the plant overview, the intuitive view immediately displays to the user that the 
plant is not in normal operation. This means that the temperature display for 
"TI_AboveFeed" is outside the work area or even above the warning and alarm 
limits. In contrast, the two measuring points "TI_BelowFeed" and 
"TI_BottomPacking" are below the work area and the warning and alarm limits. In 
addition, the KPI's energy consumption and reflux ratios are far outside the work 
area. Also, the amount of high boiler and low boiler production in the alarm area is 
easy to see in the plant overview. 

 

 

One level lower in the process screen also clearly shows the system disturbance 
with the APG library. In addition to the plant overview having determined that the 
temperatures and the KPI for energy consumption and the reflux ratio of the 
distillation vessel are not in the work area, the process screen also shows that the 
top product container has reached the lower alarm limit and that the bottom product 
container has reached the upper alarm limit. In addition, a warning is also 
displayed, showing that the steam supply has reached the upper limit for the 
maximum feed. 
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The disturbance of the plant can also be seen in the detailed process screen, 
meaning the temperature, the two KPIs for the energy consumption and the reflux 
ratio, and the tank levels are in the alarm range. However, it is not very easy to see 
if the levels are above or below the warning and alarm limits, as the example of the 
temperature displays shows. Due to the heat loss, the "TI_BelowFeed", 
"TI_BottomPacking", and "TI_HeadPacking" temperature displays have reached 
the low limit for the alarm. The additional disturbance on the temperature display 
"TI_BelowFeed" is only possible upon closer inspection of the plant. 

 

Note The controllers return the plant to the normal range even with an active 
disturbance. Only the disturbances of the displays for the temperature 
"TI_AboveFeed" and "TI_BelowFeed" remain, which are only used for display 
purposes in the OS and have no influence on the simulation. 
Furthermore, the active disturbance and the associated loss of heat lead to the 
steam supply being opened to the maximum in order to compensate for the heat 
loss, which then generates a warning message. 

 

Note By activating the disturbance, the plant leaves its normal range, triggering a few 
warning and alarm messages. These messages can be acknowledged. 
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4.14 Smart Alarm Hiding 

With the Smart Alarm Hiding, alarms of a measuring point can be filtered or hidden 
depending on the plant state. This means that the filtered and hidden alarm 
messages of the measuring points are also sent to the alarm system where they 
are processed and archived. 

A reduction in the message traffic is thus achieved in process mode, which 
simplifies the operation of a system. 

 

Smart Alarm Hiding in the example project 

The following sequence has been followed for the configuration of Smart Alarm 
Hiding. 

Incl. compile CFC

and download the AS 

Step 1: Configuration of operating states

Step 2: Configuration of status block

Step 3: Configuration of the block group

Step 4: Configuration of the hiding matrix

Incl. Download OS  

and restart OS
Step 5: Compiling the OS

 

Note Further information on Smart Alarm Hiding can be found at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/55699984. 

https://support.industry.siemens.com/cs/ww/en/view/55699984
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Step 1: 

The operating states are configured (1) in the master data library and synchronized 
in the multiproject (2) as follows. The created enumeration is called "Operating 
State". 

 

 

Step 2: 

The "STRep" status block is configured and the "State" inputs correspond to the 
operating states created in step 1. 

 

Note In the project, the plant state is selected via the step sequencers. A direct 
interconnection of upstream blocks is also possible, however only one position 
(SFC or upstream block) can be activated at any time. 
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The enumeration "Operating State" is assigned in the object properties of the 
output. 

 

 

The block group "PLANT" is predefined in the block properties. 
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Step 3: 

The technological blocks are assigned to the "PLANT" block group.  

 

 

The following technological blocks (1) belong to the "PLANT" block group (2): 

1 2

 

Note The block group defines which technological elements belong together. It is 
recommended to define the block group at the unit level. 
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Step 4: 

The Hiding Matrix has been configured for the following plant states: 

 Plant state Activation via  suppressed messages 

1.  Operation End of sequencer 
STARTUP 

None 

2.  Out_of_Operation End of sequencer 
SHUTDOWN 

All messages and alarms 

3.  Startup Start of sequencer 
STARTUP 

Lower limit values of the filling level, 
flow and pressure measurement and 
KPI  

4.  Shutdown Start of sequencer 
SHUTDOWN 

Lower limit values of the filling level, 
flow and pressure measurement and 
KPI 

5.  Product_change n. A.  

6.  Standby n. A.  

7.  Emergency n. A.  

8.  Maintenance n. A.  

 

Operation

Startup Shutdown

Out of 

Operation

ST
A

R
TU

P

SHUTDOWN

 

 

Step 5: 

The OS in the project has already been compiled and prepared for operation. 
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5 Useful information 

5.1 Basics 

5.1.1 Distillation column (rectification column) 

During distillation, a multi-component mixture is divided into at least two streams. In 
this process, the different boiling temperatures of the components are used. The 
mixture (usually liquid) is fed into the column through an inlet and vaporized.  

The gas mixture rises to the top of the column, where the mixture cools and 
condenses again. The component with a high boiling point (high boiler) 
accumulates at the base of the column (bottom) and can be removed. The 
component with a low boiling point (low boiler) accumulates at the head of the 
column and can be removed from there. The balance between the high boiling and 
the low boiling constituents shifts along the entire column.  

During the rectification process, the gas mixture is fed back again into the column 
via a reflux by means of a cooler. Thus the reflux drips in countercurrent to the high 
rising vapor down numerous shelves where it evaporates again. The rectification 
process therefore constitutes an extension of the distillation process or a series 
connection of several distillation steps.  

P
re

s
s
u
re

T
e

m
p

e
ra

tu
re

Cooler

Reflux

liquid

gaseous

Evaporator

Feed

Removal of

low boiler

Removal of high boiler

gaseous

liquid
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5.1.2 Temperature characteristic 

The quality of material separation is measured by the purity of the separation 
products, i.e. after concentration by low and high boilers in the head and bottom 
outlet. Measuring these concentrations using online analyzers is such a complex 
process, that it is omitted in most plants. On the individual trays of the column, the 
concentration of the substance in vapor and liquid are in approximate phase 
equilibrium. This means that the concentrations are highly dependent on the 
respective temperature.  

The easily measurable temperatures are used as substitute control variables. This 
has the additional advantage that the relationship between these temperatures and 
control interventions can linearize more easily than the connection with the 
concentrations.  

In the process design of the column, an s-shaped, vertical temperature profile is 
fixed inside the column to achieve the desired concentration profile and therefore 
the desired purity of the products. Two representative temperature measuring 
points are placed in the rectifying and output section of the column for control. The 
following points should be noted: 

 In order for the measuring points to react properly to the changes inside the 
column (e.g. to changes in the feed rate or the composition of the feed), they 
should be located in the part of the s-shaped profile where a significant base-
to-base temperature difference prevails. 

 The dead times of the temperature control increase with the distance from the 
measurement points to the head and bottom.  

The following figure shows the s-shaped temperature profile of a distillation column 
for two different temperature distributions.  

Temperature

curve

Representative 

temperature measuring 

points
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5.2 Details on functionality 

5.2.1 CFC naming convention 

A uniform naming convention was used for identifying the control modules, 
whereby the function has been named according to the European standard  
EN 62424. The following figure shows how a label is composed.  

FIC_Reflux

Function

F = flow (first letter)

I = indication (subsequent letter)

C = control (subsequent letter)

Name

 

The following table provides all the letters used in the application and their 
meanings: 

First letter 

Letter Meaning 

F Flow 

L Level 

N Motor 

P Pressure 

Q Quantity 

S Speed (velocity, rotational speed, frequency) 

T Temperature 

Y Control valve 

Subsequent letter 

C Control 

F Fraction 

I Indication 

S Binary control function or switching function (not safety-
oriented) ("switching") 
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5.2.2 Plant view 

The Unit Template "distillation column" is designed as a multiproject and structured 
in the plan view of an OS and AS project.  

All process screens can be found in the hierarchy folder of the OS project whereas 
the automation program is stored in the AS project in a structured manner. The 
following figure shows the structure in the plant view.  

ChColumn

DistillationGroup

Distillation

ChColumn

DistillationGroup

L2_Distillation

PDL

AS - Projekt

OS - Projekt

Plant

Plant

PDL

Distillation

L3_Distillation

PDL

SFC

StartDistColumn

CFC

KPI

CFC

Maintenace

BottomLevel

CFC

LIC_Bottom

CFC

NS_PumpBottom

CFC

YC_Bottom

Distillation

CFC

TIC_DistBottolm

CFC

TI_HeadPacking

CFC

TI_BottomPacking

Feed

CFC

FIC_Feed

CFC

Sim_Feed

CFC

YC_Feed

HeadLevel

CFC

LIC_RefluxDrum

CFC

YC_RefluxDrum

Heating

CFC

FIC_Vapor

CFC

Sim_Vapor

CFC

YC_Vapor

Pressure

CFC

PIC_ColuHead

CFC

Sim_ColuHead

CFC

YC_ColuHead

Reflux

CFC

FIC_Reflux

CFC

NS_PumpReflux

CFC

YC_Reflux

CFC

Sim_Reflux

Process

CFC

PI_ColuBottom

CFC

TI_AboveFeed

CFC

TI_BelowFeed

CFC

TI_Bottom

CFC

TI_Head

CFC

Sim_AntiWindUp

CFC

Sim_ProcModel

CFC

Sim_TempNorm
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5.3 Automation 

5.3.1 The "unit" concept 

The term "unit" represents a plant section, device, machines in a process plant 
together with the sensors, actuators and automation systems required in this 
combination of components. This unit serves as a template for identical or similar 
devices in terms of standardization. 

A subset of the process plant sections are so-called "package units". For 
examples, package units include refrigeration systems, vacuum systems and 
packaging machines. In this case, the manufacturer of the mechanical or technical 
device includes automation, specially tailored for this device, and which is mounted 
locally on special hardware on the device. The package unit is integrated as a 
whole into a process control system. No detailed knowledge of the package unit's 
automation system is required in order to plan the control system. 

In contrast to the package units, automation solutions for process plants are 
unified, pre-made and created in the unit concept in form of templates that are not 
bound to specific hardware or only partially so. Therefore, the templates must be 
only adapted to the existing hardware and the special requirements. This 
significantly decreases the engineering effort required for several similar 
automation tasks. 

Unit Template 

In a Unit Template, CMs (control modules) are combined into an automation 
function. All CM relevant blocks are connected in a CFC. A uniform naming 
convention was used for names.  

A Unit Template also contains a CFC with economic and process indicators (KPI 
parameters), a CFC for monitoring the operating time and CFC charts for 
simulation.  

The Unit Template is summarized in a hierarchy folder and can be integrated into 
existing projects. 

 

5.3.2 PCS Engineering with control modules 

A CMT (Control Module Type) in a process control system is a unified template for 
creating signal flow charts, which occur more than once in the automation system 
of a plant. The signal flow charts (CFC: Continuous Function Chart) for many 
similar measuring points are produced by forming instances of a CMT and have to 
be subsequently configured and connected with concrete measured/manipulated 
variables. The parameterization and interconnection of the CM can be automated 
by means of a mass data engineering tool.  

A Unit Template in SIMATIC PCS 7 covers all the functions required for the 
automation of a plant section:  

 CFC charts (instances of CMT) 

 SFC charts  

 OS pictures  

All functions are combined in a hierarchy folder of the SIMATIC Manager plant 
view. 
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5.3.3 Key Performance Indicators 

Key Performance Indicators are economic or procedural parameters that describe 
the production progress, the degree of fulfillment of certain requirements, or the 
quality of a plant. 

 

5.3.4 MPC controller 

The MPC controller is a model predictive multivariable controller (Model Predictive 
Control) used for the control of complex linear systems.  

If there are several manipulated and control variables influencing each other in a 
plant section, a multivariable controller leads to significantly better control results. 
The aim of the closed loop control is to run each control variable to the individual 
setpoint regardless of the other control variables. This reduces the probability that 
an intervention on a manipulated variable acts not only on a control variable but 
also affects other control variables. 

A model predictive multivariable controller additionally uses a complete 
mathematical description of the controlled system. This description allows the 
controller to calculate the process behavior over a defined period of time 
("prediction horizon") without controller intervention. An optimization method allows 
the most efficient setting strategy to be selected and the planned optimal course to 
be calculated. There are several possibilities in the formulation of the optimization 
problem. Besides the future control deviation and the adjustment effort, even limit 
values for control variables and other economic objectives can be incorporated in 
the performance criterion. 

 

5.3.5 Linearization 

Many components in industrial plants have nonlinear characteristic curves. The 
characteristic curve of many valves does not give a flow rate of 50% at 50% of the 
maximum value. The greater the deviation of the flow rate from the linear 
characteristic is, the worse the control result of a linear regulator is. Since the 
planning of a nonlinear controller is more difficult than that of a linear controller, the 
characteristics are usually linearized. 

Linearization in the operating point 

In the linearization at the operating point, it is not the entire characteristic curve 
what gets considered, but rather the part of the characteristic curve that lies at the 
intended operating point and which is required during normal operation. In the 
operating point of the characteristic curve, a tangent is laid and the deviation 
between the tangent and the characteristic curve is considered. 

Valve

stroke
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Absolute pressure
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Lower limit Upper limit
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The tangent at the operating point helps in reducing the deviations between the 
actual non-linear characteristic curve and the adopted tangent to such an extent 
that in most cases, no adjustments to the controller parameters must be made. 

If a controller is designed for the working range between the lower and upper limits 
(working range), the controller applies only for this range. If several operating 
points of a characteristic curve are required, a controller can be designed for each 
operating point and the controller parameters can be then adapted to the 
respective operating point depending on the process value. 

Linearization with compensation function 

The linearization with a compensation function is typically used when the working 
range takes up most of the characteristic curve. In this linearization, a polynomial is 
generated, which gives a linear function when multiplied by the valve characteristic 
curve. The following figure shows how the compensation function is determined 
mathematically or graphically.  

Valve

stroke

Flow rate

Deviation

Linear characteristic

Valve 

characterisitc

Compensation function
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5.4 Further Notes, Tips and Tricks, etc. 

5.4.1 Configuration of the PID controller 

The program "PID Tuner" is available for the configuration of the PID controller. 
This program determines the optimum PID parameters for the connected controlled 
system. The following instructions describe the general procedure using the 
example of the PID controller in the CFC "FIC_Feed". 

Note A practical example for operating the "PID Tuner" can be found at: 
https://support.industry.siemens.com/cs/ww/en/view/8031495. 

Requirements 

 The controller is connected to the process or to the simulation. 

 The control program is compiled and loaded. 

CAUTION The optimization results in an intervention in the system process. You should be 
aware of the implications this may have. 

To obtain an optimal result, carry out the controller optimization between the 
minimum and maximum working range of the corresponding variable (for 
FIC_Feed: 15-25). 

During optimization, observe the process constantly from the curve recorder. 

Granting optimization release 

The program "PID Tuner" runs on the engineering station (ES). Since the operator 
control and monitoring station (OS) and the ES do not generally run on the same 
computer, PCS 7 offers the coordination of users function. The release takes place 
in the operating screen of the controller (View > Parameters). With this release, 
you grant the engineering system (PID Tuner) the right to intervene actively in the 
process. The respective possible operations on the OS are blocked during 
optimization.  

To use the program "PID Tuner", the value "1" must be present at the "OptimEn" 
input of the "PIDConL" block. If you want to set this input in the ES, follow the 
steps 1 to 5. If the release on the OS was granted, start with step 1 in the section 
"Performing controller optimization". 

1. Open the PCS 7 project in the plant view. 

2. Open the folder hierarchy "Ch Column_AS_Prj > ChColumn > 
DistillationGroup> Distillation > Feed" and double-click the chart "FIC_Feed".  
The CFC editor is opened. 

3. In the menu bar of the CFC Editor, click on "Test > Test mode" and confirm the 
"Log in CPU for testing" dialog with "Yes". 

4. Double-click the block "C" in sheet 1 of the CFC and click on the "Connections" 
tab. 

5. Change the value of the connection "OptimEn" to the value "1" and confirm 
with "OK". Then close the block. 

https://support.industry.siemens.com/cs/ww/en/view/8031495
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Carrying out the controller optimization 

The following instructions describe controller optimization for a control system with 
PT behavior. 

1. Click on "Edit > Optimize PID controller..." in the menu bar of the CFC editor.  
The PID Tuner opens. 

2. Click the "stop" button under the curve recorder to stop the recording and then 
click the "Settings" button. 

 

 

3. Insert appropriate Y axis limits for the 3 curves (setpoint, actual value, 
manipulated variable). 

4. Adapt the "Acquisition cycle" and the "Timeline length" to the expected process 
behavior and confirm your entries with "OK". 

Note For detailed information on controller optimization, refer to the online help. To 
open the online help, click the "Help" button in the lower part of the PID Tuner. 

5. Click on the "Start Controller Optimization" button in the lower part of the PID 
Tuner. 

6. In Step 1, select the check box "without integral component in the process 
from" and click "Next". 

7. In the group "Operating mode" select the "Automatic" check box. Enter the 
typical operating point (e.g. 20 L/min) of the control variable. Please observe 
the warning in the lower part of the dialog and then click "Next". 

8. As a "Step excitation, new setpoint:" enter a setpoint (e.g. 25 L/min.) well 
above the typical operating point. Please observe the warning in the lower part 
of the dialog and then click "Next". 
The controller optimization has now been completed. 

9. After completing the optimization, select the check box "Withdraw" in the 
"Processes excitation" group. Please observe the warning in the lower part of 
the dialog and then click "Next". 

10. In the group "Controller design to", select the "Optimal control behavior" check 
box and click "Next". 
An additional window will open with the identification result. 
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11. In the "Controller parameters" group, select the check box of the PI controller 
and click "Next". 

12. In step 8: "Simulate a control loop with the optimized parameters", click "Next". 

13. Click the "New" button to implement the determined values. 
Heed the warning in the lower part of the dialog and then click "Finish" to 
complete the optimization. 
 

5.4.2 Configuration of the MPC controller 

Step responses form the basis for the controller design. These are incorporated in 
the manual mode of the controller and recorded in trend curves. The trend curves 
show all excited manipulated variables and all control variables. The excitation of 
the manipulated variables begins at the operating point and contains a step to the 
upper limit and to the lower limit (linearization in the working point) of the typical 
position value for the operation of the plant. Each change in the manipulated 
variable is only carried out when the system has reached a steady state. The same 
procedure can be used for measurable disturbance variables. These can be 
considered in the controller design.  

Trend curves can be additionally evaluated for checking (verification) the controller 
design. 

The required trend curves can be created and exported in the CFC trend display. 

For more information, see the "Help" section of the MPC configurator under 
"Details on the individual design steps > Recording of measurement series". 

Note You can find a detailed description in the application example "Model Predictive 
Control including integral transfer functions" at the following link 
https://support.industry.siemens.com/cs/ww/en/view/42200753 

 

CAUTION In-process interventions are necessary to configure the MPC controller! 

Before the process intervention, check what implications it will have and inform 
the appropriate personnel. 

 

Trend recording 

1. Open the PCS 7 project in the plant view. 

2. Open the hierarchy folder "ChColumn_AS_Prj > ChColumn > DistillationGroup 
> Distillation > Distillation" and double-click the "TIC_DistBottom" chart. 
The CFC editor is opened. 

3. Open the trend display from the menu "Display > Trend display". 

4. Drag all relevant process values to the trend and set the upper and lower limits 
for each value. 

 

https://support.industry.siemens.com/cs/ww/en/view/42200753
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5. Register the CPU in test mode. 

6. In the excitation block "AutoExcitation", enter the parameters "StepSize", 
"Duration" (duration of excitation) and the number of manipulated variables 
(interconnected controllers with MPC). 

 

7. In the process screen (OS) of the distillation column, change the mode of the 
multivariable controller "TIC_DistBottom" to Manual.  

8. Switch back to the CFC and start the trend recording using the "Start" button. 

9. Wait about 40 seconds until the first values (no steps) are recorded.  

10. In the excitation block, start the process excitation with the value "1" at the 
connection "StartExcite" and wait until all the excitation processes are 
completed.  

11. Export the trend recording after excitation is complete. 

12. Switch to the process screen (OS) of the distillation column and change the 
mode of the multivariable controller "TIC_DistBottom" to Auto.  

Process identification 

1. Open the PCS 7 project in the plant view. 

2. Open the hierarchy folder "ChColumn_AS_Prj > ChColumn > DistillationGroup 
> Distillation > Distillation" and double-click the "TIC_DistBottom" chart. 
The CFC editor is opened. 

3. Select the block "MPC" and click in the menu bar on "Edit > Configure MPC". 
The MCP Configurator opens. 

4. Click the button "Load data" and select the file containing the exported trend 
curves. Click "OK" to confirm your selection. 
The selected trend curves are uploaded to the group "Raw data". 

5. In the drop-down lists to the right of the trend displays, select the displayed 
signal and press the "Step by Step" button. 

6. Determine the period for authentication, select the check box "Process with 
dead times" and then click the "Identify" button. 
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7. In the "Controller parameters" group, enter the controller cycle time (the OB 
cycle time in which the controller is called) and the DB number for the process 
model. 

 

 

8.  Then click the "Design controller" button. This opens the "MPC – verification 
and simulation" dialog. 

Note The quality of the trend curves is displayed in the upper left corner of the dialog 
"MPC process model". The quality should be above 50% for a controller design. 

9. Click the "Load data" button in the group "Verification of the process model" 
and select the file with the verification data in the file selection dialog. 
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10. The verification is started and the quality of the process model is shown. 

11.  Click on the "Simulate control loop" button to check the value range. 

12. The result between button and trend display is subsequently rated and can 
also be viewed by clicking the trend display. 

13. Click on the "Export SCL code" button and select the folder where to save the 
SCL source file in the file selection dialog that follows. 

14. Enter a name for the file and click on "Save". 

15. Confirm the message with "OK" and then close all dialog boxes of the MPC 
configurator and the CFC. 

16. Save the session log of the MPC configurator by right-clicking on the user 
interface background. 

 

Generating a data block from the process model 

1. Switch to the component view of the project. 

2. Right click on "ChColumn_AS_Prj > AS01 > CPU 410-5H > AS01 > Sources" 
and in the menu item choose "Insert new object > External source...".  

Note In the project path "<Project path>\ChColumn", you can find the exported SCL 
source file "ChColumn_MPC_DB41.scl". 

 

3. Select the SCL source created previously and click on "Open". 
This SCL source file is imported. 

4. Double-click the SCL source file and click on the menu bar "File > Compile" in 
the open SCL editor. Then close the SCL editor. 

Note In the first line of the source code you will see the currently applied DB number 
of the block. In order not to overwrite the available one, this should be changed 
to the value 41 
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CAUTION If a data block already exists with that DB number, you will receive a message 
asking if you want to overwrite the data block. Data blocks should only be 
overwritten if you know their exact function. If in doubt, interrupt the compiling 
process and change the DB number of the first line to a non-allocated DB 
number. 

The MPC function block must be invoked at the appropriate watchdog interrupt 
OB. The cycle time of the OB and the specified time "OB-Timing" in the head of 
the SCL source must be identical. 

 

5. Right-click on "ChColumn_AS_Prj > AS01 > CPU 410-5 > AS01 > Charts" and 
double-click the chart "TIC_DistBottom", which contains the MPC controller. 

6. Select the input "DB_No" and change the value to the number of the previously 
generated data block. 

  

 

Note The process model is updated the next time the control is compiled and 
uploaded. 

If the control program has already been uploaded, the DB number can also be 
changed online. In order to do this, the DB must be uploaded to the controller 
and the "Restart" input set online to "Reset". Steps may occur in the manipulated 
variable after restarting the controller. 
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6 Appendix 

6.1 Service and support 

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks: 
https://support.industry.siemens.com 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. Please send queries 
to Technical Support via Web form: 
www.siemens.com/industry/supportrequest 
 

SITRAIN – Training for Industry  

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 
www.siemens.com/sitrain  
 

Service offer 

Our range of services includes the following:  

Plant data services 

Spare parts services 

Repair services 

On-site and maintenance services 

Retrofitting and modernization services 

Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 
https://support.industry.siemens.com/cs/sc 
 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone:  
https://support.industry.siemens.com/cs/ww/en/sc/2067 

https://support.industry.siemens.com/
http://www.siemens.com/industry/supportrequest
http://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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6.2 Links and literature 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to the entry page for the application example  

https://support.industry.siemens.com/cs/ww/en/view/48418663 

\3\ SIMATIC PCS 7 Overview - Quick Start 

https://support.industry.siemens.com/cs/ww/en/view/63481413 

\4\ Model Predictive Control including integral transfer functions 

https://support.industry.siemens.com/cs/ww/en/view/42200753 

\5\ Controller optimization with the PID Tuner 

https://support.industry.siemens.com/cs/ww/en/view/8031495 

\6\ Integration of Advanced Process Graphics in SIMATIC PCS 7 

https://support.industry.siemens.com/cs/ww/en/view/89332241 

\7\ Equipment Modules for PCS 7 using the Chemical Industry as an example 

https://support.industry.siemens.com/cs/ww/en/view/53843373 

\8\ PCS 7 Unit Template using the example of the "Stirred Tank Reactor" from the 
chemical industry 

https://support.industry.siemens.com/cs/ww/en/view/60546560 

\9\ PCS 7 Unit Template using the example of the "Fermenter" from the chemical 
industry 

https://support.industry.siemens.com/cs/ww/en/view/68098270 

\10\ PCS 7 Unit Template using the example of the chemical industry "Dryer" 

https://support.industry.siemens.com/cs/ww/en/view/74747848 

\11\ PCS 7 Unit Template using the example of the Chemical Industry "Polymerization 
Reactor" 

https://support.industry.siemens.com/cs/ww/en/view/84061788 

\12\ How do you procure documentation for PCS 7 (including the PCS 7 Manual 
Collection)? 

https://support.industry.siemens.com/cs/ww/en/view/59538371 

 

 

6.3 Change documentation 

Version Date Change  

V1.0 02/2011 First edition 

V1.1 06/2013 Valid for PCS 7 V7.1 SP1 and V8.0 SP1, additional links, 
minor text corrections 

V2.0 10/2015 Integration of APG, Update for PCS 7 V8.1 SP1 

V3.0 05/2018 Integration of Smart Alarm Hiding, addition of chapter 
"Detecting Deviations in Process Mode with APG" and 
Update for PCS 7 V9.0, Note on Managed System Services 
in Chapter 1.3 

 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/48418663
https://support.industry.siemens.com/cs/ww/en/view/63481413
https://support.industry.siemens.com/cs/ww/en/view/42200753
https://support.industry.siemens.com/cs/ww/en/view/8031495
https://support.industry.siemens.com/cs/ww/en/view/89332241
https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/60546560
https://support.industry.siemens.com/cs/ww/en/view/68098270
https://support.industry.siemens.com/cs/ww/en/view/74747848
https://support.industry.siemens.com/cs/ww/en/view/84061788
https://support.industry.siemens.com/cs/ww/en/view/59538371
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